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1 OVERVIEW 

This document is compatible with the Spectra Resolver software 1.5.2.626 and above. 
 

The LW-10 laser wavelength meter provides the wavelength (or frequency or wavenumber) of 

narrow linewidth lasers with high-resolution in the visible and NIR range. 

The unit is calibrated before delivery and is extremely simple to use. Thanks to its compactness, 

the LW-10 can be easily integrated into existing systems. 

 

Instrument description 

The LW-10 package includes a compact hardware (the device includes no moving parts), a PC 

Software application and the necessary cables. The light to be analyzed is coupled to the hardware 

by a single-mode fiber. 

 

Fields of application 

The LW-10 device is the ideal tool for laser wavelength measurement in the range 700-1000 nm 

(wider range optionally). It is able to display the current laser wavelength with an absolute accuracy 

better than 200 MHz and can detect wavelength changes down to 20 MHz. In addition, several 

trigger mode options offer a unique configuration for the testing of pulsed lasers or the stability 

checking of continuous lasers. Furthermore, its user interface, SpectraResolver, includes wavelength 

detection over time display and other visualization and recording features.  
 

Note that the LW-10 wavelength meter is dedicated to measurement of single frequency lasers 

(pulsed and CW) with linewidth narrower than 30 GHz. Possible applications cover: 
 

 Tunable laser control 

 Laser stability control 

 Frequency locking 

 

Available options are: 

 Multi-channel 

 Analog Output (for Laser control PID) 

 Laser spectrum analyzer function 

 

Patents 

The LW-10 is based on SWIFTSTM technology, which is protected by patents owned by UJF, INPG, 

UTT and CNRS and licensed to RESOLUTION Spectra Systems. SWIFTSTM is a new technology enabling 

innovative compact high-resolution and laser wavelength meters. 
 

SWIFTSTM - Stationary-Wave Integrated Fourier Transform Spectrometer: 

 Based on interferometry and the Lippmann Transform principle 

 Uses semiconductors, integrated optics and nanotechnologies 
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2 SPECIFICATIONS 

Specifications 

(1) Performance guaranteed on the 700 – 1000 nm range. 

(2) T° calibrated on 16-30°C. For quality check, an absolute accuracy calibration procedure is available 

with SpectraResolver. Not frequently required. 

(3) Warm-up: best performances are achieved under steady state conditions, typically ambient 

temperature stable at +/- 0.5°C per hour maximum, constant air flow, LW-10 running for more than 

30 minutes. No sensitivity to air pressure variation. 

(4) According to 3σ criterion. 

(5) Computational speed.  PC hardware and settings dependent. 

(6) Coupled in Polarization Maintaining singlemode fiber. 

 

Functionalities 

Characteristics Contend 

Compatibility Windows 7 – 8 – 10 

Unit change nm (vacuum and standard air) / cm-1 / THz 

Software development kit server/C++, Python, DotNet, Vis libraries 

Trigger Front Trigger 

 

These functionalities are accessible with SpectraResolver software. 

Specifications Value 

Wavelength range (1) 700 - 1000 nm 

(optional: 630 – 700 / 1000 – 1100 nm) 

Wavelength resolution (1) 20 MHz 

Absolute accuracy (1) (2) (3) (4) 200 MHz 

Maximum linewidth 30 GHz 

Measurement speed (5) > 20 Hz 

Exposure time 16 µs - 10 s 

Input power range (6) 10 nW – 1000 µW 

Optical input PM singlemode fiber N.A. 0.12 

Fiber connection FC/APC 

Power consumption 11 W to  48 W @ 24V DC 

Communication Gigabit Ethernet + USB 2.0 

Dimensions 149 x 86 x 80 mm 

Weight 1046 g 
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3 PRECAUTIONS FOR USE 
 

WHAT TO AVOID 
  

 Never inspect or clean a fiber-optic cable without first disconnecting the entire cable assembly 

from the optical source. Failure to take this precaution may seriously damage your eyesight. 

 Never clean the instrument without first disconnecting the power supply cable. Failure to take 

this precaution may seriously damage it. 

 Never clean the instrument with water or another liquid. Failure to take this precaution may 

seriously damage it. Use only a cloth moistened with water to clean external casing parts. Do 

not attempt to clean the internals. 

 Never connect directly to AC power, use the power supply provided with the LW-10. 

 The ventilation fan must not be obstructed by any objects, as this may cause to overheat the 

instrument. Failure to take this precaution may seriously damage it. 

 Do not open the LW-10. The warranty will be rendered null and void if the user attempts to 

open or repair the product. 

 

 

CAUTION 
 

 If this instrument is not used as specified in this document, the warranty is no longer valid. 

 Keep the FC/APC connector’s protective cap in place when you are not using the instrument. 

 For optimal performance, be careful when handling fiber-optic connections. Always clean the 

fiber end and the FC/APC connector (with dry air) prior to inserting it into the instrument’s 

fiber-optic connector. Failure to do so may result in damage to the instrument. 

 It is mandatory to properly and fully screw the optical fiber to the LW-10. Failure to do so may 

result in damage to the instrument. 

 If you use a power supply other than that provided with the LW-10, make sure that its voltage 

is 24V DC (2 A Minimum). 

 Excessive levels of humidity can damage the LW-10. If the instrument has been stored in an 

extreme environment (moisture, heat, cold), it should be kept in normal operating conditions 

for a certain amount of time before being switched on. 

 

 

TIPS 
 

 It is strongly advised that the light analyzed at the entrance of the LW-10 (input connector) is 

polarized in TE mode (locked to PM slow axis). If not correctly polarized, the data may be 

distorted and the resolution may be deteriorated. Use polarizing fiber. Contact us for your 

polarizing fiber solution. 

 Less than 2 seconds after the power has been switched on, the LED lights up ORANGE. Please 

wait for the LED to turn GREEN before launching SpectraResolver software. 

 After the start data acquisition, it is advisable to wait at least 30 minutes before the first 

measurement (minimum warm-up time for temperature stabilization inside the instrument). 

 Caution: to ensure accurate data, make sure the correct integration time has to be selected 

otherwise please select ‘Best dynamic control’. 
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4 GETTING STARTED 

 

The instrument is delivered with the following items: 

 The LW-10 

 Single-mode polarization-maintaining (PM) fiber with FC/APC connectors or Polarizing fiber 

with FC/APC connectors depending on the configuration ordered 

 24V (2A or above) power supply with power cable 

 Ethernet cable (2 m, Cat6) 

 USB key with installation software and documentation (User Manual) 

 

The following options if they have been selected: 

 Trigger cable 

 Polarizing and filtering accessories 

 Switch box 

 Analog Output Control 

 

To start using the LW-10, please read paragraphs 5 and 6. 

 

If you need any further information, please do not hesitate to contact us (info@resolutionspectra.com) 

 

mailto:info@resolutionspectra.com
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RJ45 

Ethernet connector 

Hirose 12-pin 

Trigger connector 

 

Hirose 6-pin 

Power connector (24 V) 

 
LED indicator 
For status and diagnostics 

FC/APC           

Fiber 
connector 

5 HARDWARE INTERFACE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fiber connector 

FC/APC connector: Use a single-mode polarization-maintaining (PM) fiber or a polarizing fiber. 

It is strongly recommended to properly and fully screw the optical fiber on the FC/APC connector. 
 

If not correctly polarized, the data may be distorted and the 

wavelength calculation may deteriorate. It is highly recommended to 

use a fiber optic polarizer with angled FC/APC connectors and 

polarization maintaining fiber. 

 

Ethernet connector 

Use the Ethernet cable supplied with the LW-10, or another Ethernet 

cable (cat6), to connect the instrument to a computer. 

 

Power Connector 

Use the power supply and cable supplied with the LW-10. 

To insert the connector, simply turn it slightly. 

When you hear a “click”, the connector is properly inserted.  

 

LED indicator 

The LED indicates the status of the LW-10: 

Color and state Meaning 

Green and continuous OK 

Green and blinking slowly Waiting for external trigger (Trigger mode) 

Red and continuous Instrument is out of order (internal firmware error) 

Orange and continuous Initialization phase 
 

Trigger connector 

Use this connector if you need to operate in trigger mode, see the “Trigger selector” chapter for 

further information. For easier and faster connection to an external trigger signal, RESOLUTION 

Spectra Systems can offer a Trigger cable. Please contact info@resolutionspectra.com. 

mailto:info@resolutionspectra.com
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6 SOFTWARE INTERFACE 

SpectraResolver gives full control over acquisition parameters and data management. All data can 

be stored (.txt or .csv files). Graphs can also be saved as image files (.jpg, .bmp, .png, .tiff, .pdf, 

.svg). SpectraResolver complies with the GigE Vision® standard and the GenICam SFNC standard. 

 

Installing SpectraResolver software 

SpectraResolver must be installed prior to connecting the LW-10 to the computer. This will install 

all the drivers the instrument requires. If SpectraResolver is not installed first, the LW-10 will not be 

recognized. Install the SpectraResolver software (provided on the USB Key) and follow the 

instructions. During the first installation SpectraResolver needs eBus SDK, if it is not already 

installed, follow instructions, please install only driver for gigabit Ethernet – not USB3.0. 
 

During the installation you have to enter a password. . 
 

After installation, a shortcut icon will be available on your desktop . 
 

Before upgrading SpectraResolver software, SpectraResolver interface must first be closed, the 

LW-10 disconnected and UninstallSpectraResolver launched. 

 

Initial set-up 

The LW-10 can be used with any computer that meets the following requirements: 

 Gigabit Ethernet network (it operates only at a transfer rate of 1Gbit/s in full-duplex mode) 

 Processor frequency 2.6 GHz (minimum requirement) 

 Up to 4 Go RAM 

 100 MB of space free on hard drive 
 

The basic start-up process is as follows: 

1. Connect the fiber 

2. Connect the Ethernet cable 

3. Switch on the LW-10 (having connected the 24V power supply with the power cable) 

4. Wait for the LED indicator to turn GREEN 

5. Launch SpectraResolver with the shortcut icon  
 

When first opening SpectraResolver, the software takes few minutes to load the calibration tables 

on the computer. The software will then automatically link the calibration table with the serial 

number of the instrument. 

  

The password is supplied on USB Key. 
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Warm-up 

 
 

A 10 minutes warm-up time is required to ensure the best performances of LW-10. The timer on 

the play button gives an indication on the remaining warm-up time. 
 

For instance, the button  shows that 8 minutes and 48 seconds are needed to complete the 

warm-up.  

 

Skipping this step might lead to worsen performances, measurement inaccuracy and long 

term-drift. 
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Starting out with SpectraResolver 

Wait for the LED to turn green before launching SpectraResolver. 
 

To start data acquisition click on the “Start acquisition”  button. The following window appears 

(the figure below describes the main functions of SpectraResolver). 
 

 

 

 

 

 

 

The main control parameters are: 

 Acquisition mode 

 Exposure time 

 Start / Stop / Record acquisition 

 Signal level 

 

 

SpectraResolver is able to measure: 

 Wavelength 

 

 

 Wavelength over time 

 

 

 Figure of merit 

 

  

Data selection 

Wavelength over time 

Wavelength measurement Modes 

Figure of merit 

Functions Controls 
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Controls 

 These two icons allow selecting how data is acquired. 

Tool Function 
 

Continuous Continuous acquisition 
 

 

Multiframe 

 

In this mode, the icon  appears in the “Control” area. It allows you to 

specify a certain number of acquisitions. 
 

Front Trigger 

 

Front Trigger mode, see chapter Trigger selector 
 

 

 

 

 

 

Trigger setup window, see chapter Trigger selector 
 

 

The following icons are used to manage data acquisition. 

Tool Function 
 

 

 

Start data acquisition. In progress play button turns blue:  
 

 

 

 

Stop the acquisition in progress 
 

 

 

 

 

Start data acquisition with recording. A file is created containing the data acquired 

 

The following parameters are used to control data acquisition. 

Tool Function 
 

 

 

 

Integration time in µs (Min=16 µs. Max=10 s). 
 

 
 

 

When the Best dynamic control box is checked, the integration time is determined by an 

algorithm so that the intensity on the detector array remains between 30 % and 95% of 

the maximum dynamic of the detector. When the intensity goes outside these limits, the 

Best dynamic control algorithm starts and there is no measurement available until a 

suitable integration time is found again. 
 

 

 

 

 

Measurement rate Min=0.01Hz. Typ=20 Hz. Max=600 Hz. 

 

This icon indicates the signal level. It is advisable to work only in optimal configuration. 

Too weak (< 30%) Optimal (30% to 94%) Too close to saturation (> 94%) 
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Trigger selector 

This icon  opens the “Trigger Setup” window. 

In Trigger mode the averaging (frame count) is automatically set to 1. 
 

The “Front Trigger” mode is recommended for synchronization and acquisition with a pulsed laser. 

The initial setting is: exposure starts at the rising edge of the signal trigger (TTL signal) with no 

delay.  
 

  

 

The exposure time is monitoring by this parameter: . 

 

Exposure Time + Trigger Delay must be lower than Trigger period. 

If it is higher than Trigger period, the signal trigger is lost. 
 

Example of timing: 

 if trigger frequency = 200Hz  Exposure Time + Trigger Delay must be < 5 ms 

 if trigger period = 1 ms  Exposure Time + Trigger Delay must be < 1 ms 

  

The start of the exposure can be delayed. 

 Trigger Delay (Min) = 0,03 µs 

 Trigger Delay (Max) = 10000000 µs (100 s) 

 Trigger Delay = 0  no delay 

 

It is mandatory to indicate the following 

parameters of trigger signal: 

 The sense (rising or falling edge) 

 The electrical level (TTL or LVDS) 

 The frequency of trigger (Hz) 
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Wavelength measurement 

This window indicates the laser’s wavelength: 

 

 

 

 

 

 

 

With a right-click the unit of the wavelength measure can be changed to: wavenumber (cm-1), 

wavelength (nm) and frequency (THz, is the default unit). 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Air wavelength is calculated for standard dry air (15°C and 760 mm Hg).  

 

The measurement is stopped if: 
 

 The intensity of signal is too weak 

 

 The intensity of signal is too strong 

 

 The wavelength of signal is out of bounds 

 

 Untrusted wavelength measurement 

   

 

 

  



 
 

Ref: RES1602UM101 

This document is the property of RESOLUTION Spectra Systems. Not to be disclosed or copied without prior written consent  14/33 

Range of wavelength measurement 

Defining a wavelength range measurement is possible to increase the real-time measurement rate 

of the device. To activate the function, “Range” in the Display menu. 

  

 

Wavelength range (Typical) 

 Min = 700 nm  

 Max = 1000 nm  

 

Example: 

 Change “Min” value and write 1050.44 nm 

 Change “Max value” and write 1072.17 nm 

 Confirm the modification with button “Apply” 

 

 

 

Please do not use this function if you do not know in advance the approximate wavelength value of 

the laser. If the true wavelength value is located outside the measurement range, wrong wavelength 

values can be displayed.   
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Figure of merit 

A figure of merit is displayed on SpectraResolver interface. Its purpose is to give an indication on 

the current running state of the laser: single mode, multimode or reduced coherence. 

The chart displayed is a convergence function. This figure does not represent a physical quantity 

and should only be taken as an indicator on the laser running state. Its axes represent normalized 

vectors adjusted to display a readable figure for quick understanding. 
 

If the laser is single mode with good coherence, the valley displayed on the figure of merit must 

fulfill these two requirements: 

 Centered  

 Amplitude as low as possible 

 

If these two conditions are met, the figure of merit 

is likely to be as follows: 

 

If the current figure of merit displayed by SpectraResolver is not equivalent to the above graph, the 

wavelength measurement may not be meeting the LW-10 specifications. The following examples 

show different cases where the laser is not single mode or lacks of coherence: 

 

 

 Low amplitude = Not OK! The laser is likely to lack of 

coherence (> 30 GHz) 

 

 

 

 Not centered = Not OK! The laser is likely to lack of coherence 

(> 30 GHz) and/or is not singlemode 

 

 

 

 Two low amplitude valleys = Not OK! The laser is likely to be 

running multimode (two modes or more). 

 

 

 

If no figure of measure is displayed, it signifies that SpectraResolver algorithm could not find a 

suitable result and/or does not trust the wavelength measurement. For example: 

 The laser beam spectrum is broader than 30 GHz 

 The laser source is running multimode (2 modes or more) 

 The laser source is not correctly polarized 

 

If this is your case, try to get a better signal from your source or check your setup/laser 

polarization.  
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Wavelength over time 

This function allows the tracking over time of the wavelength value.  

 

 

 

 

 

SpectraResolver also offers a range of options to view, customize or save graphs. 
 

Tool Function 
 

 

 

 

Activate zoom mode (Left click or Mouse-Wheel) 

 

 

 

 

Zoom to fit the whole curve 

 

 

 

 

Zoom to fit the whole horizontal curve 

 

 

 

 

Zoom to fit the whole vertical curve 

 

 

 

 

Set the windows boundaries 

 

 

 

 

Show or hide grid 

 

 

 

 

Activate or deactivate marker mode 

(Add Delta Marker) 
 

 

 

Save current graph to image file  

(*.jpg, *.pdf, *.svg, *.ps, *.bmp, *.png, etc.) 
 

 

 

 

 

Save current graph as an (.txt or .csv) file 

 

 

 

 

Copy plot to clipboard 

 

 

 

 

Clear data on the graph 
 

 

 

 

 

Display only the last 30 seconds 

 or all the measurement if selected 
 

   

 

 

Hide mean value on the graph or other value (see next page) 
 

 

 

 

Display the deviation from a reference wavelength (see next page) 

 

When an icon is activated it is highlighted  (orange color).  

Zoom 
functions 

Save 
functions 

Graphic 
functions 

 Current value 

 Average 

 Standard deviation 

 Min value 

 Max value 

 

With a right-click the unit of the wavelength measure can be changed to: wavenumber (cm-1), 

wavelength (nm) and frequency (THz). Frequency is the default unit). 
 

Data 
functions 

With the right-click you can 
show or hide current value. 

780.2415 nm 
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 : Hide mean value on the graph and display all the measurement  

 

In “Wavelength Over Time” mode: the overtime graph can be centered on a transition ray using 

the following procedure: 

1. A new transition ray should be added to the wavelength list (in “Option/Preference” menu). 

 
 

2. Select the transition ray  

 
 

3. and click on this button . 
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Recalibration tool 

For the best results, make sure the device has been properly adjusted and calibrated beforehand. 

The calibration process especially should be undertaken periodically (and if remarkable 

environmental conditions have changed) to reach the specified precision. 
 

The Recalibration tool can be found in the “Option/Recalibration” menu. 
 

  

 

 
 

 

 

All calibrations are saved on the computer. 

 

  

All calibrations are recorded and may be reused. 

Factory calibration 

Recalibration at 633.645820 nm 

Recalibration at 633.645819 nm 
 

1. Current value (measured) 

2. Enter the reference laser value for recalibration 

3. Click OK to active recalibration 

4.  

If the calibration value is too far from the measured 
value, the software highlights the value. 
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TCP/IP server 

TCP/IP server: allows the remote control and acquisition of the measured wavelengths via TCP/IP. 

 

Open “Option/Preference” menu  

  

 

Open “Display/TCP/IP” window  

    

  

Start / Stop Server 
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Recording 

 This icon starts spectral data acquisition with recording (and stop record with the same icon). 

  : No recording 

  : Recording in progress 
 

The format of the file name is MM_DD_YYYY_hh_mm_ss_iii_0.srr (MM: Month / DD: Day / YYYY: 

Year / hh: hour / mm: minute / ss: second / iii: millisecond). It is possible to read the recorded file 

in the "Replay" tab. For more information, please read the next chapter. If the user activates the 

peak detection while recording, it will be displayed in replay mode. 
 

The menu “Option/Preference” Tab “Data Saving” manages the recording parameters. 

 

 

It is also possible to save the current graph as (.csv) or (.txt). 

 

 

The file is created with button , the csv and text files are organized as follows: 
 

    

 

  

Select the save folder 

Select the file size of the recording 

 Min = 1 MB 

 Typ = 5 MB 

 Max = 50 MB 
 

If the computer has only 4 GB of RAM the 

file size must be lower than 20 MB 

 

Select the save folder 

Select the type of file (txt or csv), 

and the decimal separator 

 

Excel cannot open a .csv file if it 
is larger than 10MB 
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Replay mode 

The recorded data can be replay in the “Replay” tab. 

First the measurement has to be loaded, and then it can be read as if it was a real time 

measurement. To start “Replay” mode you must first choose a recorded file. To do this just select a 

directory and load the desired .srr file. 

 

 

 

 

 

 

  

Directory selection 

File selection 
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7 OPTIONS 

Analog Output plugin 

To perform wavelength stabilization, frequency locking, PID control or just deviation measurement 

on a single-mode laser signal, the LW-10 wavelength-meter offers the capabilities of an analog 

output feature. Its control is done via an external USB-DAQ device providing a voltage proportional 

to the wavelength measured by the LW-10. The output voltage has a large covering range from -10 

V to +10 V with a step resolution of 1.22 mV, according to its 14-bit Digital-to-Analog Converter 

(DAC) resolution. The signal can be accessed using a coaxial BNC connector (other solutions on 

demand). 
 

Specifications Value 

Analog Output Voltage Range ± 10 V DC 

Step Resolution 1.22 mV DC 

DAC Resolution 14-bit 

Absolute Accuracy (typical), at full scale 9.1 mV 

Maximum Sample Rate  5 kS / s 

Output Impedance 0.2 Ohm 

Output Connection Coaxial BNC  

Communication interface USB 

Operating System Windows 7 – 8 - 10 
 

If the analog output option has been chosen, an analog output control dialog box is made available 

under the menu item “Plugins” -> “Analog Output” of the SpectraResolver software. The dialog box 

allows the switching on and off of the device, and the output setting adjustment. 
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Installation 

After a clean installation of SpectraResolver software (see “User Manual LW-10”), please install 

Analog Output plugin with the “Spectra Resolver Analog Output Plugin.exe” installer provided in the 

USB key. 

Make sure that the LW-10 wavelength-meter and the USB-DAQ are not connected when installing 

the software and the plugin. The option will require the installation and the use of National 

Instrument DAQ Runtime library (NI-DAQmx provided in the USB key). Restarting the computer may 

be necessary to complete the installation. After a clean installation, please first connect the LW-10 

wavelength-meter and then the USB-DAQ device. Please wait for the driver installation and the 

Ethernet connection. Launch SpectraResolver software and check the availability of the “Analog 

Output” option in the “Plugins” toolbar. 
 

If the “Multi-Channel” option is also available with SpectraResolver software and the optical 

switch device connected, the “Analog Output” option is no longer available. To recover access 

to this option, please disconnect the optical switch device and start again SpectraResolver 

software 

 

Analog Output functionalities 

 Reference wavelength 

The “Reference” wavelength must be set for value in vacuum. All deviations will be determined in 

function of the value. In order to be activated, the box “Use analogic output” must be checked. 

 Sensitivity and Polarity 

The “Sensitivity” sheet allows the control in sensitivity of the generated voltage (in Volt) in 

relation with the wavelength deviation, with V/µm, V/nm, V/pm and V/fm ranges. The “Polarity” 

is accessible in “Positive” and “Negative” to control the sign of the voltage deviation. 

 

  

Analog output reference sensitivity 
 

Analog output reference polarity 
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 Bounds 

Signal bounds: Maximum and minimum signal bounds can be defined in the +/- 10 000 mV 

voltage range (in mV). If the absolutes of both the values are different, it is possible to adjust the 

reference wavelength to the center of both the values or to “0 mV” value. 

 

            

 

Behaviour on exceeding: If the signal exceeds the signal bounds' interval, the user can choose to 

leave the signal simply being cut or to send an other specific entered values. If the values to be 

entered here overlap with the signal bounds range, the commands are marked with an orange 

warning color but still taken into account. Also it is recommended that these signals should vary 

from all the other used voltage values of the other “Error Signals” sheet. 

 

 Errors Signals 

Specific voltages can be set to appear if the measurement has led to an error value because of 

optical signal dynamic too low or tow high, or in case a correct wavelength is not found. To 

enable these error signals, the check box “Use error signals” must be activated. If the values (in 

mV) to be entered here overlap with the signal bounds range, the commands are marked with an 

orange warning color but still taken into account. Also it is recommended that these signals 

should vary from all the other used voltage values of the other “Bounds” sheet. 

  

Adjustment of reference to center of range Adjustement of reference to the zero 

signal in the bounds of range signal in out of range Cut signal 

Activation of the error 

signals with values out of the 
signal bounds range 

Activation of the error 

signals in the signal bounds 
range (still taken in account) 

No activation of the signal 
error 
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Multi-Channel Switch plugin 

The LW-10 wavelength-meter offers the capabilities of interfacing with a specific fibered optical 

single-mode switch to serve for the most demanding applications in testing and measurement. The 

optomechanical design (MOEMS) of the switch ensures an excellent optical performance combined 

with short switching time due to refractive micro-optical components and industry proofed high 

resonant actuators. Thanks to its SpectraResolver, the LW-10 wavelength-meter is able to analyze 

and monitoring up to 4 lasers almost simultaneously (other numbers of channels on demand). 
 

Specifications Value 

Number of channels 4 

Operating Wavelength Range 630 - 1000 nm 

Insertion Loss  < 3 dB 

Crosstalk  < -55 dB 

Fibers type PM single-mode fibers 

Polarization extinction ratio PER 20 dB 

Connector type  FC-APC  

Switching frequency 50 Hz max. 

Guaranteed lifetime > 108 cycles 

Communication interface RS232 or USB 

Operating voltage 5 V 

Power consumption < 450 mW 

Operating temperature 0 – 60 °C 
 

If required as an option, the feature is available under the menu “Plugins > Switch” of 

SpectraResolver software, opening a dialog box. Switching on and off independently each of the 4 

channels can be done in this dialog box. 
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Hardware installation 

The power supply connection of the switch box should be done as follows: 

 

 

As shown in the picture above, the blue indicator of the flat cable should face the VCC pin. 

 

Software plugin installation 

After a clean installation of SpectraResolver software (see “User Manual LW-10”), please install 

Multi-Channel Switch plugin with the “Spectra Resolver Optical Switch Plugin.exe” installer provided 

in the USB key. 

Be sure that the LW-10 wavelength-meter and the optical switch are not connected when installing 

the software and thie plugin. The communication is done via a serial RS232 connection. If the USB 

connection is preferred (USB to Serial converter provided), the option will require the installation 

and the use of the Brainboxes Boost Runtime library (installer provided in the USB key). Restarting 

the computer may be necessary to complete the installation. After a clean installation, please first 

connect the LW-10 wavelength-meter; then connect the optical switch device with the RS232 or USB 

connection and plug its power supply. Please wait for the driver installation and the Ethernet 

connection. Launch SpectraResolver software and check the availability of the “Switch” option in the 

“Plugins” toolbar. 
 

If the “Analog Output” option is also available with SpectraResolver software and the optical 

switch device connected, the “Analog Output” option is no longer usable. To recover access to 

this “Analog Output” option, please disconnect the optical switch device and start again the 

SpectraResolver software 

 

Multi-Channel Switch functionalities 

 Choice of activated channels and Configuration 

The Optical Switch Plugin box allows to switch on and off independently each of the 4 channels.  
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Please note that the “Exposure time” and other parameters cannot be defined independently for 

each channel. The cycle time of measurement can be configured with the “Measurement Rate 

setting” command. 

    

 

 Wavelength overtime 

Each channel is linked to a specific graph over time, where the current measured wavelength is 

screened in a blue box, and the signal dynamic of the channel is provided in the bottom right of 

the graph (in %). Zoom, saving, and scaling functions are accessible independently for each 

channel.  Statistical data can be also determined for each evolution in the Display tab, and the 

figure of merit linked to the wavelength calculation convergence is accessible for each channel 

(see “LW-10 User Manual” for more details). 
 

 

 Graph Settings 

The displays of the graphs over time are accessible with the check boxes of the « Wavelength 

switch » menu in the « Devices » toolbar. Please note that these settings does not desactivate the 

switch operation but only the display. 

 
 

The SpectraResolver software offers the possibility to display the different graphs over time in 

successive lines (“Column” display mode) or in a square configuration (“Grid 2x2” display mode). 

The “Switch display mode” is available over the menu “Options > Preferences > General” of 

SpectraResolver software. 

 

All chanels selected 
Only All chanels 

selected 

statistic data 

graph over time 

graph over time 
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In both modes, each channel can independently benefit from the display (zooms, cursors, 

deviation to reference scaling) and saving functions (see “LW-10 User Manual” for more details). 
 

 

Multi-Channel Switch measurement of 4 different lasers around 632-636 nm (Grid display 

mode),  with different display functions (evolution vs. mean value (top, left), deviation to 

reference (top, right), or classical screenings (bottom)). 
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8 TROUBLESHOOTING 

The LW-10 does not start 

Status: LED indicator is off (no light) and the fan does not work. 

1. Check the connection with LW-10 Power Connector 

2. Check the connection to the AC power supply 

3. If the LW-10 still does not work, change the 24V power supply and power cable or contact 

Resolution Spectra Systems info@resolutionspectra.com 

 

No connection 

Status: no communication with the device (the window “no device found” appears”), the fan works. 

1. If the LED still lights up ORANGE after 40 seconds, please contact info@resolutionspectra.com 

2. If the LED lights up GREEN, check the Ethernet cable (connection to PC and spectrometer) it 

must be connected and the LED of Ethernet connector must be ON 

3. Verify the connection of Gigabit Network. It must be 1 Gbits/s 

4. Launch Spectra Resolver, if no communication please contact info@resolutionspectra.com 

 

Firewall incompatibility 

Status: Lost communication after few seconds or no data. 

Firewall blocking transmission: Disable firewalls and re-attempt a connection. 
 

This section provides you with the steps to take to disable the Windows 7 firewall. In the Windows 7 

operating system you can control the firewall setting for domain networks (corporate), home or a 

public network. We recommend that you do not deactivate the firewall on a public network. 

 

To set your network type 

1. Click Start > Control Panel. 

2. Click Network and Internet. 

3. Click Network and Sharing Center. 

4. Adjust the network settings.  

5. Close the Control Panel.  

To disable the firewall on Windows 7 

1. Click Start > Control Panel.  

2. Click System and Security.  

3. Click Windows Firewall.  

4. In the Control Panel Home, click Turn Windows Firewall On or Off. 

5. Select Turn Off Windows Firewall  

6. Close the Control Panel. 
 

Note: If disabling the firewall has no effect: Antivirus may also block the transmission: Disable 

Antivirus and re-attempt a connection. 

 

Secure network 

Status: Lost communication after few seconds or no data. 

 Many networks (corporate) are secured and might block the connection to the instrument. To 

overcome this, please use another Gigabit Ethernet port by added 

1. USB3.0 Gigabit Ethernet adapter (Example product: D-Link DUB-1312 

(depend on product, in trigger mode you may have some limitation) 

2. PCI card Gigabit Ethernet. 

   

mailto:info@resolutionspectra.com
mailto:info@resolutionspectra.com
mailto:info@resolutionspectra.com
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Limitation of PCI network adapters 

This document present the knowledge about different manufacturer driver we acquire based on 

experience, validation and customer reports. This is a work in progress and this document will be 

updated as our knowledge improves about the different products on the market. Limitations noted 

were found during the eBUS Universal Pro validation process. Information may be relevant to other 

drivers but was not validated with them. Minor issues with a couple of adapters have been observed 

but the eBUS Universal Pro can install on top of any network adapters with good results.  
 

Intel are still selling really good network adapter and are more likely to provide a great experience to 

work with. Intel is the preferred vendor. 

 

Connection lost 

If this windows appears 

 

Status: The connection with the device has been lost 

1. Check the connection with LW-10 Power Connector 

2. Check the connection to the AC power supply 

3. Verify the connection of Gigabit Network. It must be 1 Gbits/s 

4. Launch Spectra Resolver, if no communication please contact info@resolutionspectra.com  

mailto:info@resolutionspectra.com
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9 PRODUCT SUPPORT 

Please read the document “General Terms and Conditions RESOLUTION Spectra Systems” for the 

conditions and the term on warranties. 

 

To make a warranty claim, the purchaser shall promptly notify RESOLUTION Spectra Systems 

following discovery of the basis for the claim (and, in any event, within the applicable warranty 

period). To facilitate any repairs/changes, you must first contact Customer Support and obtain a 

Return Merchandise Authorization (RMA) number. Contact us by Email, in writing or by telephone: 

 

RESOLUTION Spectra Systems 

Address: 13 chemin du Vieux Chêne – 38240 Meylan France 

Tel.: 00 33 458001249 – Fax: 00 33 458001252 

Email: info@resolutionspectra.com 

 

 

The warranty is rendered null and void if the purchaser attempts to service or repair the product 

(other than performing the routine maintenance described in the User Manual), or if servicing is 

performed by an individual not authorized by RESOLUTION Spectra Systems. 

 

 

Spectra Resolver provides an after sale service options storing all the product parameters in order 

to allow a better analysis of the problem. Open the menu “Option/Product Support” and follow the 

instructions. 
 

 
 

At the end of the procedure, a file is created:  

 

Please note, for any technical support or RMA, thank you to send this file with an explanation 

of the defect. 

 

  

1. Choose directory 

2. Click on Process 

3. Close window 
 

mailto:info@resolutionspectra.com
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10 STANDARD COMPLIANCE 

The instrument has been tested using the following equipment: 

 24V (2 A) power supply delivered with LW-10 

 An Ethernet cable Cat6 

 

CE compliance 

The instrument complies with the requirements of EMC (European) directive 2004/108/EC           

(EN 50081-2, EN 61000-6-2). 

 

FCC compliance 

The instrument complies with Part 15 of the FCC rules, which states that its operation is subject to 

the two following conditions: 

 The device must not cause harmful interference 

 The device must accept any interference received, including interference that may cause 

undesired operation 

This equipment has been tested and found to comply with the limits for a Class A digital device, 

pursuant to part 15 of the FCC rules. These limits are designed to provide reasonable protection 

against harmful interference when the equipment is operated in a commercial environment. This 

equipment generates uses and can radiate radio frequency energy and, if not installed and used in 

accordance with the instruction manual, may cause harmful interference to radio communications. 

Operation of this equipment in a residential area is likely to cause harmful interference, in which 

case the user will be required to correct the interference at his own expense. 

 

RoHs compliance 

The instrument complies with the requirement of RoHs directive 2002/95/EC. 

 

Environmental considerations 

In the European Union, this label indicates that this product should not be disposed of 

with household waste. It should be deposited at an appropriate facility to enable recovery 

and recycling. 
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11 MECHANICAL DRAWINGS 

 

All dimensions are in mm. 

 

 

 

 

 


